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1.

Introduction

Thank you for purchasing the Xilinx Spartan-3 Development Kit. You will find it
useful in developing your Spartan-3 FPGA application.

FPGASP3 Kit (DPK) is an exclusive general-purpose kit for the SPARTAN family.
The intention of the design is to endorse the engineers and scholars to exercise
and explore the capabilities of FPGA architectures with many interfacing modules on board point
LEDs, Slide switches, Traffic light, LCD, 7-Seg, UART, VGA, and PS/2 with ease to create a stand-
alone versatile test platform.

1.1 - Packages

m ﬁy* e Spartan3 Development Kit (XC3S200)
sl 2 e Serial Port Cable

e JTAG Programming Cable

e Printed User Manual

e CDcontains
o0 Software (Programmers, ISE)
0 Example Programs
0 User Manual

1.2 - Technical or Customer Support

E-mail questions to : support@pantechsolutions.net

Send questions by mail to
Pantech Solutions Pvt Ltd.,
151/34, Mambalam High Road,
Sri Ranga Building, T. Nagar,
Chennai - 600 017

Tamilnadu, India

Phone 1 +91-44-4260 6470
Fax 1 +91-44-4260 6350
Website : www.pantechsolutions.net
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2. Key Components and Features

On-Chip Features

e 200,000-gate Xilinx Spartan 3 FPGA in a 144-TQFP (XC35200-4TQG144C)

= 4,320 logic cell equivalents

= Twelve 18K-bit block RAMSs (216K bits)
=  Twelve 18x18 hardware multipliers

= Four Digital Clock Managers (DCMs)

= Up to 97 user-defined I/0 signals

On-Board Features

10 Nos. Slide Switches for digital inputs

10 nos. of Point LEDs for Digital outputs

2 Nos. of Push Button

2x16 Character LCD interface

4 Nos. 7-segment LED CA display

2 Nos. of 5V SPDT Relay with termination.

4x4 Matrix Keypad interface

4-Way Traffic Light controller Module

Stepper motor Driver interface

DC Motor interface controlled by PWM

3-bit, 8-color VGA display port.

RS-232 Serial Port.

PS/2-connector( for mouse/keyboard interface) port
128x64 GLCD Module Interface (Optional)

Serial EEPROM (Optional)

I2C Real Time Clock with battery back-up (Optional)
1-Wire Digital Temperature Sensor (Optional)

50 MHz crystal oscillator clock source

20-pin 1/0 connector for interface external peripherals modules
JTAG port for download user program through cable
9V AC/DC power input through adapter

On-board 5V, 3.3V, 2.5V, and 1.2V regulators.
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2.1- General Block Diagram
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3. Jumper & Switch Details

Stepper /Relay ® 006 Internal Supply (+5V)
JP5
(1) External Supply(+5V)
DC Motor 000 Internal Supply (+5V)
JP6
®®0 | Exiernal Supply(+5V)
Buzzer (PS) ® 006 Enable Buzzer
JP7
(1) Disable Buzzer

Switch Details

Program Execution Mode Selection (EXE MODE)

JTAG/PROM
J6

Execution through JTAG

Execution through PROM

GLCD / Traffic Light Selection

GLCD/Traffic
SW28

Select GLCD

Select TRAFFIC

+5V Power Selection

Swi

e s

BlW|N|-
[$2] [o2] EN] [e4)

>§
P2
P2

SW DIP-4

P7SEG
PLCD
PSM/RL
PGLCD
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4. Connector Details

20pin — Box Connector

J7
1063 1 2 1068
1069 3 4 1070
1073 ? 6 1074
1076 s ?o 1077
1078 11 1 1079
1080 e 1 1082
1083 = 1 1084
101
10102 e 1 0103
19 20
1 CONN TRBLK 8x2 —
+5V
JTAG Connector
J2
1 T™MS
2 TDI
3 TDO
4 TCK
5 GND
6 VCC
CONG6
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5. Power Supply

The external power can be AC or DC, with a voltage between (9V, 1A output) at 230V AC input.
The SPARTAN3 board produces +5V using an LM7805 voltage regulator, which provides supply to
the peripherals.

USB socket meant for power supply and USB communication, user can select either USB or Ext
power supply through SW1. Separate On/Off Switch (SW1) for controlling power to the board.

ON/OFF l Power +5V ON -External through Adaptor

SW2
r Power +5V ON - Internal through USB

There are multiple voltages supplied on the Spartan-3 Evaluation Kit, 3.3V, 2.5V and 1.2V
regulators. Similarly, the 3.3V regulator feeds all the VCCO voltage supply inputs to the FPGA’s
I/0 banks and powers most of the components on the board. The 2.5V regulator supplies power
to the FPGA’s VCCAUX supply inputs. The VCCAUX voltage input supplies power to Digital Clock
Managers (DCMs) within the FPGA and supplies some of the I/0 structures.

In specific, all of the FPGA’s dedicated configuration pins, such as DONE, PROG_B, CCLK, and the
FPGA’s JTAG pins, are powered by VCCAUX. The FPGA configuration interface on the board is
powered by 3.3V. Consequently, the 2.5V supply has a current shunt resistor to prevent reverse
current. Finally, a 1.2V regulator supplies power to the FPGA’s VCCINT voltage inputs, which
power the FPGA’s core logic. The board uses four discrete regulators to generate the necessary
voltages.
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6. On-board Peripherals

The Development Kit comes with many interfacing options

8 Nos. Slide Switches for digital inputs

8 nos. of Point LEDs for Digital outputs

2x16 Character LCD interface

4 Nos. 7-segment LED CA display

2 Nos. of 5V SPDT Relay with termination.

4x4 Matrix Keypad interface

4-Way Traffic Light controller Module

Stepper motor Driver interface

DC Motor interface controlled by PWM

Buzzer Interface

UART for serial port communication through PC
GLCD | 12C EEPROM | RTC | 1-Wire Temp Sensor (Optional)
JTAG Programmer

Clock Source

3-bit, 8 Color VGA Interface

PS/2 Keyboard interface

9
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6.1 - Light Emitting Diodes

e Light Emitting Diodes (LEDs) are the most commonly used components, usually for displaying
pin’s digital states.

o The FPGASP3 KIT has 8 nos., of Point LEDs, connected with port pins (details tabulated
below); the cathode of each LED connects to ground via a 330Q resistor. To light an
individual LED, drive the associated FPGA control signal to High.

Point LEDs XC35200 - Pins LED Selection

LED-D9 P14

LED-D10 P15
wn LED-D11 P17 LED1
e P R1 330E |
= LED-D12 P18 . o &
'_
) _
3 LED-D13 P20
EI LED-D14 P21 Make Pin High — LED ON
a LED-D16 P24

LED-D29 P50

LED-D30 P53
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6.2 — Digital Inputs

This is another simple interface, of 8-Nos. of slide switch, mainly used to give an input to the

port lines, and for some control applications also.

The FPGASP3 KIT, slide switches (SW20-SW27) directly connected with FPGA 1/0 lines (details
tabulated below), user can give logical inputs high through slide switches.

The switches are connected to +3.3V, in order to detect a switch state, by default lines are pull-

downed through resistors. The switches typically exhibit about 2 ms of mechanical bounce and

there is no active de-bouncing circuitry, although such circuitry could easily be added to the FPGA

design programmed on the board. A 10KQ series resistor provides nominal input protection.

Slide Switch | XC3S200 - Pins Slide Switch Logic

SW20 P25

Sw21 P26

SW22 P27 vee

R 10k

% Sw23 P28 . 251
) swi
o R
E SW24 P30 10k *
= W2 P31 = '
= SW25 :
Q
@) SW26 P32 Make Switch Close — High

SwW27 P33 Make Switch Open — Low

SW29 P93

SW30 P103

11
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6.3 — 2x16 Char LCD Display

The 2x16 character LCD interface card with supports both modes 4-bit and 8-bit interface, and
also facility to adjust contrast through trim pot. In 8-bit interface 11 lines needed to create 8-bit
interface; 8 data bits (DO — D7), three control lines, address bit (RS), read/write bit (R/W) and
control signal (E). The LCD controller is a standard KSO070B or equivalent, which is a very well-
known interface for smaller character based LCDs.

LCD MODULE | XC35200-Pins 2x16 LCD Selection

. RS P104
=
E RW P105
3 E P107

DO P108

D1 P112
" D2 P113
L
Z D3 P116
—l
E D4 P118
a D5 P119

D6 P122

D7 P123

+5V
=, OFF SWl—« ON
cic Make switch SW1 to ‘LCD’ 2 =217 o
N=C_i" label marking position — =l %
PWR ON/OFF
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6.4 — 7-Segment Display

The Spartan-3 FPGASP3 Kit has a four-character, seven segments LED display controlled by FPGA
user-1/0 pins. Each digit shares eight common control signals to light individual LED segments.
Each individual character has a separate anode control input. The pin number for each FPGA pin
connected to the LED display is shown in below table. To light an individual signal, drive the
individual segment control signal Low along with the associated anode control signal for the
individual character.

7-Segment XC3S200-Pins 7-Segment Display
Digit - 1 P124
8 Digit - 2 P125 v
3 — . 1K J
2 Digit - 3 P127 S 2
[a) ®
Digit - 4 P128
Seg-a P129 e o it B
Sega 7T, < <«
Seg—b P130 S E °
seg-d 2
B Seg-c P131 seae 1] 2 I_!
£ 3 <0 1_|I
- eg—-d P132 seodp 5 gp -
(=
GE" Seg-e P135 e 7 SEG DISP
(o]
o Seg - f P137 f Iﬁlb Make high to - digit selection
Seg—g 140 e |£|C Make low to - segment
Seg—-dp P141
BV
Swi
SR . . s OFF 1 —i| 8 ON
(8 Make switch SW1 to ‘7SEG — — - gSEG
N=C_5" |abel marking position =
PWR ON/OFF
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6.5 - 4x4 Matrix keypad and Push Button

Keypads arranged by matrix format, each row and column section pulled by high, all row lines

and column lines connected directly by the i/o pins.

4x4 Matrix Keys XC3S200-pins Matrix Format
ROW-1 P85
= ROW-2 P86 a_o_s&.w_o_l _o_sz.vz_o_l _0—5*'“—0_1 _o_s&.v%_|
(@] R1
2 ROW-3 P87
ROW-4 P89 e | ] ] ] ]
COLUMN-1 P90 s |she [she (5t
- s —O O—J —O 0—1 —O 0—1 —O 0—|
S| COLUMN-2 P92 s | swie | s | _swws
=) Lo Lo Lo Lo
§ COLUMN-3 P95 = ] ] i ]
COLUMN-4 P96

The Spartan3 FPGA Kit has four contact push button switches for interrupt input.

PUSH BUTTON XC3S200-pins
SW31 P103
SW32 P102
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6.6 — Stepper Motor

The ULN2803A is a high-voltage, high-current Darlington transistor array. The device consists of
eight NPN Darlington pairs that feature high-voltage outputs with common-cathode clamp
diodes for switching inductive loads. The collector-current rating of each Darlington pair, 500

maA.

ULN2803 is used as a driver for port 1/0 lines, drivers output connected to stepper motor,
connector provided for external power supply if needed.

Stepper Motor(5V) | XC35200-Lines Sllager M sitar PR saleel

CO I L_A P82 VvCC MOTOR_PWR eppER
% COIL-A H— 1 )
= core]INt €% ouTt D)
= COIL-B P83 I 88%\‘ = @
% O ENL D i
% COIL-C P99 JP5
b COILD P100 O 0O Internal +5V (Stepper Motor)

o SW1
%) Make switch SW1 to SM/RL label S n = %
s E | 6 SM/RL

—C.r marking position. APWRE?FF :

For Motor/relay designer get power from on-board (internal) or external supply through jumper
JP5, by default JP5 pin 1&2 shorted
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6.7 - DC Motor

5V DC Motor speed has controlled through PWM signal. Motor can run both clockwise/counter
clockwise, Motor speed controlled by varying ENA (duty cycle) signal through program.

DC Motor(5V) XC3S200-Lines DC Motor PWR Select
vCccC
COIL-A P82 0 MOTOR SERVO
o PWM1 -2 1 2
: e A RS
S COIL-B P83
(&)
[a)]
ENA P99 1Pe
©® @O Internal +5V (Stepper Motor)
+5V
[y SWI—{ N
o Make switch SW1 to SM/RL label - %
€5 marking position. I = s
PWR ON/OFF

For DC Motor designer get power from on-board (internal) or external supply through jumper

JP6, by default JP6 pin 1&2 shorted.
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6.8 — Relay Interface

ULN2803 is used as a driver for port I1/0 lines, drivers output connected to relay modules.

Connector provided for external power supply if needed.

Relay Module : Spartan3 FPGA pins (Realyl — P59) and (Relay2-P60) for relay module,
make port pins to high, relay will activated

RELAY SPDT XC35200-pins RELAY Power Select
+5V

(%) SW1

i) Relay-1 P59 L OFF1 [~ —¥lg ON

=) O e e A

3 -7727 e Q §SM/RL

= I

2 PWR ON/OFF

m Relay-2 P60 PS

©® ®/® Internal +5V (Stepper Motor)
Qe Note :Relay selection make switch SW1 to SM/RL label marking position

S—C_5

For Motor/relay designer get power from on-board (internal) or external supply through jumper
JP5, by default JP5 pin 1&2 shorted.

6.9 — Buzzer Interface

5V continuous buzzer connected through FPGA’s I/0 pins (P5), to enable buzzer place jumper JP7

at E label mark position.

Buzzer Module : Spartan3 FPGA pins (Buzzer — P5), make port pins to high, buzzer will activated

5V Buzzer XC3S200-pins RELAY Power Select
= P7
N Buzzer P5
3 ©®@®© - ToEnableBuzzer
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6.10 — Traffic Light Controller

Traffic light controller card consist of 12 Nos. point led arranged by 4Lanes. Each lane has Go

(Green), Listen(Yellow) and Stop(Red) LED is being placed. Each LED has provided for current
limiting resistor to limit the current flows to the LEDs.

: LAN_ XC3S200-pins | LED’s Traffic Light Controller
Direction
NORTH P40 D19-Go
P36 D18-Listen GO N 330E
P35 D17-Stop e =
WEST P46 D22-Go HISTER) -
P44 D21-Listen 330E
P41 D20-Stop ST()P_N_M_
SOUTH P51 D25-Go LanE Make high to -LED On
P50 D24-Listen o Make low to —LED Off
P47 D23-Stop LANE . o LL LI
EAST P56 D28-Go e s EAST sw2g
P53 D27-Listen ° r
P52 D26-Stop SOUTH Traffic
ge Note : Make SW28 to “Traffic” label marking position
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7 - Peripherals Section - II

7.1 - RS-232 Communication (USART)

USART stands for Universal Synchronous Asynchronous Receiver Transmitter. FPGASP3 Kit provides
an RS232 port that can be driven by the Spartan-3 FPGA. A subset of the RS232 signals is used on the
Spartan 3 kit to implement this interface (RxD and TxD signals).

e RS-232 communication enables point-to-point data transfer. It is commonly used in data
acquisition applications, for the transfer of data between the microcontroller/FPGA and a PC.

o The voltage levels of a FPGA and PC are not directly compatible with those of RS-232, a level
transition buffer such as MAX3232 be used.

UART SPARTANS3 . .
. Serial Port Section
DB-9 Connector FPGA Lines

TXD P15
E SPARTAN3  [¢
<
>

RXD P14

7.2 —Clock Source

The FPGASP3 Kit has a dedicated 50 MHz series clock oscillator source and an optional socket for

another clock oscillator source.

Oscillator

u18 Signal SPARTANS Crystal Oscillator
Igna
g FPGA Lines y

50MHz Clock P55 [ .J
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7.3 - JTAG Programmer

The FPGASP3 Kit includes a JTAG programming and debugging chain. Pantech JTAG3 low-cost
parallel to JTAG cable is included as part of the kit and connects to the JTAG header. DB-25
parallel port connector to 6 pin female header connector. The JTAG cable connect directly to the
parallel port of a PC and to a standard 6 pin JTAG programming header in the kit, can program a
devices that have a JTAG voltage of 1.8V or greater.

6-Pin . SPARTAN3
Header JTAG Signals FPGA Lines
1 TMS P111
= 2 TDI P144
o % 3 DO P109
= = 4 TCK P110
,_-% 5 GND
6 VCC

JTAG Cable - 1lI

The Pantech low-cost parallel port to JTAG cable fits directly over the header stake pins, as
shown in above figure. When properly fitted, the cable is perpendicular to the board. Make sure
that the signals at the end of the JTAG cable align with the labels listed on the board. The other
end of the Pantech cable connects to the PC’s parallel port. The Pantech cable is directly
compatible with the Xilinx iIMPACT software.
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7.4 -VVGA Interface

The FPGASP3 Kit includes a VGA display port through DB15 connector, Connect this port directly
to most PC monitors or flat-panel LCD displays using a standard monitor cable As shown in table,
the Spartan-3 FPGA controls five VGA signals: RED (R) its 1ST pin in connector, GREEN (G) its 2nd
pin, BLUE (B) its 3rd pin, Horizontal Sync (HS) 13th pin, and Vertical Sync (VS) its 14th pin, all
available on the VGA connector.

VGA port, view from Wire Side

FGREEN
BLUE
N/C
GND

N/CH

H-SYNCH
V-SYNCH

DELY VGA Signals SPARTANB
Connector FPGA Lines
Vertical Sync(VS) P6
Horizontal Sync(HS) P7
Blue P8
Green P10
Red P11

Each color line has a series resistor to provide 3-bit color, with one bit each for Red, Green, and

Blue. The series resistor uses the 75 ohm VGA cable termination to ensure that the color signals
remain in the VGA-specified OV to 0.7V range. The HS and VS signals are TTL level. Drive the R, G,
and B signals High or Low to generate the eight possible colors shown in below table.

RED GREEN BLUE RESULTING COLOUR
0 0 0 BLACK
0 0 1 BLUE
0 1 0 GREEN
0 1 1 CYAN
1 0 0 RED
1 0 1 MAGNETA
1 1 0 YELLOW
1 1 1 WHITE

VGA signal timing is specified, published, copyrighted, and sold by the Video Electronics
Standards Association (VESA). The following VGA system and timing information is provided as
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an example of how the FPGA might drive VGA monitor in 640 by 480 modes. For more precise
information or for information on higher VGA frequencies, refer to documents available on the
VESA website or other electronics Websites: Video Electronics Standards Association

http://www.vesa.org

VGA Timing Information
http://www.epanorama.net/documents/pc/vga_timing.html

Signal Timing for a 60Hz, 640x480 VGA Display

CRT-based VGA displays use amplitude-modulated, moving electron beams (or cathode rays) to
display information on a phosphor-coated screen. LCD displays use an array of switches that can
impose a voltage across a small amount of liquid crystal, thereby changing light permittivity
through the crystal on a pixel by- pixel basis.

Although the following description is limited to CRT displays, LCD displays have evolved to use
the same signal timings as CRT displays. Consequently, the following discussion pertains to both
CRTs and LCD displays. Within a CRT display, current waveforms pass through the coils to
produce magnetic fields that deflect electron beams to transverse the display surface in a
“raster” pattern, horizontally from left to right and vertically from top to bottom.

As shown in below figure, information is only displayed when the beam is moving in the
“forward” direction—Ieft to right and top to bottom—and not during the time the beam returns
back to the left or top edge of the display. Much of the potential display time is therefore lost in
“blanking” periods when the beam is reset and stabilized to begin a new horizontal or vertical
display pass.

The size of the beams, the frequency at which the beam traces across the display, and the
frequency at which the electron beam is modulated determine the display resolution. Modern
VGA displays support multiple display resolutions, and the VGA controller indicates the
resolution by producing timing signals to control the raster patterns. The controller produces
TTL-level synchronizing pulses that set the frequency at which current flows through the
deflection coils, and it ensures that pixel or video data is applied to the electron guns at the
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(F— pixel 0.0 pixel 0,628 1]

.

B840 pixels are displayed each
time the beam traverses the scresn

VGA Display

Retrace: Mo
Current infarmation
through the T pixel 478,0 pixel 478,628 ]

is displayed
harizontal N during
deflaction : . this time
cail N H
L N Stable current ramp: Information is

>- displayed during this time

Total horizental time

Horizental display time . retrace time .

time

r"badt porch r back porch”

ws L L L

Horizontal sync signa L front porch”
sets the refrace frequency

correct time. Video data typically comes from a video refresh memory with one or more bytes
assigned to each pixel location.

The Spartan-3 Evaluation Kit uses three bits per pixel, producing one of the eight possible colors
shown in above table. The controller indexes into the video data buffer as the beams move
across the display. The controller then retrieves and applies video data to the display at precisely
the time the electron beam is moving across a given pixel.

The VGA controller generates the HS (horizontal sync) and VS (vertical sync) timings signals and
coordinates the delivery of video data on each pixel clock. The pixel clock defines the time
available to display one pixel of information. The VS signal defines the “refresh” frequency of the
display, or the frequency at which all information on the display is redrawn. The minimum
refresh frequency is a function of the display’s phosphor and electron beam intensity, with
practical refresh frequencies in the 60 Hz to 120 Hz range.

The number of horizontal lines displayed at a given refresh frequency defines the horizontal
“retrace” frequency.
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7.5 -PS/2 Interface

The FPGASP3 Kit includes a PS/2 port and the standard 6-pin mini-DIN connector, labeled U11 on
the board. User can connect PS/2 Devices like keyboard, mouse to the FPGASP3 KIT. PS/2’s DATA
(P8) and CLK (P10) lines connected to SPARTAN3 FPGA I/0 Lines.

EERT LI PS/2 SPARTANS PS/2 PORT SELECT
Connector FPGA Lines
Uil DATA P1 SPARTAN3 |
PS/2
S CLK P2
Tok Tek PS/2 keyboard connector {(MINI-DING
Edge 0\| el |;Ed;e 10 Y ( )
CLK (PS2C) Connector Pin # Purpose
T I | Pin 1 KEDAT (data)
TSU—-I_.]-—I“— HLD | Pin2 not used
DATA (PS2D) _\—EEDU_}_ Pin3 GND
/' Pin4 YCC (+5V)
\ . Pins KBDGLK (clock)
Ostartpit | SoPbi Pin® e

10use connector pinout is identical to PS/2 keyboard

Both a PC mouse and keyboard use the two-wire PS/2 serial bus to communicate with a host
device, the Spartan-3 FPGA in this case. The PS/2 bus includes both clock and data. Both a mouse
and keyboard drive the bus with identical signal timings and both use 11-bit words that include a
start, stop and odd parity bit. However, the data packets are organized differently for a mouse
and keyboard. Furthermore, the keyboard interface allows bidirectional data transfers so the
host device can illuminate state LEDs on the Keyboard.

The PS/2 bus timing appears as shown in above figure. The clock and data signals are only driven
when data transfers occur; otherwise they are held in the idle state at logic High. The timing
defines signal requirements for mouse-to-host communications and bidirectional keyboard
communications. The attached keyboard or mouse writes a bit on the data line when the clock
signal is High, and the host reads the data line when the clock signal is Low.
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Keyboard

The keyboard uses open-collector drivers so that either the keyboard or the host can drive the
two-wire bus. If the host never sends data to the keyboard, then the host can use simple input
pins. A ps/2-style keyboard uses scan codes to communicate key press data nearly all keyboards
in use today are ps/2 style. Each key has a single, unique scan code that is sent whenever the
corresponding key is pressed.

The scan codes for most keys appear in below figure. If the key is pressed and held, the keyboard
repeatedly sends the scan code every 100 ms or so. When a key is released, the keyboard sends
an “f0” key-up code, followed by the scan code of the released key. the keyboard sends the
same scan code, regardless if a key has different shift and non-shift characters and regardless
whether the shift key is pressed or not. The host determines which character is intended. Some
keys, called extended keys, send an “e0” ahead of the scan code and furthermore, they might
send more than one scan code. When an extended key is released, an “e0 f0” key-up code is
sent, followed by the scan code.

ESC F F2 F3 F4 F5 FB Fo || 10 || F11 || F12
05 05 01 09 T8 07 EO07
11 |[2@ || 3% || 48 6‘ ?& B‘ - =+ ||Back Space
(E 15 18 || 26 .55 Jb 31.: JL 4c 45 55 || = &6
TRE [.{ i T
0D 1: ?4 ).,_, 55 .3C d ] 411 24 5B 5D
capsLock e Enter
'Em 1"’& 23 "L 34 33 3B 42 4]3 o 53& EUQ;.’Z
Shlﬂ "‘7‘ Shlﬂ
12 "‘2 Zl ‘3}\ 3” ’l 3.& :l.l 49 dq 59

Cirl Alt Space |
14 29

-

A

-153\3’:3]

E011 | z:o 4

The host can also send commands and data to the keyboard. Below figure provides a short list of
some often-used
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Commands

Command Description

ED Turn on/off Num Lock, Caps Lock, and Scroll Lock LEDs

EE Echo. Upon receiving an echo command, the keyboard replies with the same
scan code “EE”.

F3 Set scan code repeat rate. The keyboard acknowledges receipt of an “F3” by
returning an “FA”, after which the host sends a second byte to set the repeat
rate.

FE Resend. Upon receiving a resend command, the keyboard resends the last scan
code sent

FF Reset. Resets the keyboard

The keyboard sends commands or data to the host only when both the data and clock lines are
High, the Idle state, Because the host is the bus master, the keyboard checks whether the host is
sending data before driving the bus. The clock line can be used as a clear to send signal. If the
host pulls the clock line Low, the keyboard must not send any data until the clock is released.
The keyboard sends data to the host in 11-bit words that contain a ‘0’ start bit, followed by eight
bits of scan code (LSB first), followed by an odd parity bit and terminated with a ‘1’ stop bit.
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7.6 - 128x64 GLCD Graphical LCD

The FPGASP3 KIT is the GLCD. 14 pins are needed to create 8-bit interface; 8 data bits (DB0-DB7),
two chip select line (CS1) and (CS2), address bit (R/S), read/write bit (R/W) and control signal (E)
and Reset (RST). The GLCD controller is a standard S6B0108 or equivalent, which is a very well-

known interface for Graphical based LCDs.

Figure below illustrate the GLCD part of the design and which pins are used for the interface. The

GLCD is powered from the 5V power supply enabled by switch SW1.

GLCD XC3S200 LINES 128x64 GLCD Selection
Cs1 P35
0 CS2 P36
O v
e 2 RS P40
Z =
9 R/W P41
E P44
DBO P46
DB1 PA7
fa DB2 P50
=
= DB3 P51
<
o DB4 P52
a
| DB5 P53
)
] DB6 P56
DB7 P57
RST High
SwW28 +5V
%(3 T Sw2s
\v Mak . GLCD OFF; —_ goN
N > Make switch SW1 and SW28 H=1 %
to ‘GLCD’ label marking position 4P el :’ eLeD
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Pin Details of GLCD

Pim No. Symhbaol [0 Tyvpe Description
Clhap selz2ction
1 O34 - . -
Tyt = "= =
2 c<3 [ When C31=L.C52=H., sel=c1 IC1
When C51=I1.C52=L_ selzct [C2
3 VSs Supply Ground
4 DD Supply Puwer supply
5 o Supply LLLY dower supply voitage
& DI Data input/output pin of internal shuft register
MS SHL n1o1 D1o2
H H Oulpu Ouipul
H L Chatput Outpat
L IT Tnput Ciput
L L Chatput Tyt
Read o1 Wiz
EW Dezcriprion
. o H Jata appears at DB| 0] and can be rzzd by the C2L
: RW while
E-H C51B-L,C52B-L and C53-H
L Display data DB[7:0] czn be written a2t falling edz= of T
when C510-T. C5I0-1 and CE3-IL
Enablz signal
£ E E Descriprion
II Fead data in DI 7:0] appears while T— “TTigh™.
L Display duta DB[7.0] 1 laichizd al falling edee 0 2.
Data bus [0-7]
916 DRO-DR7 | IO :
Dii-directional cata bus
L Fezet signal.
When R3TB-L
[ 1] ON/OFF register becomes sct by 0.(display off)
17 EsST [ 71 dsplay statt line register hecnmeas set by 0 (7-sodress O set display
from linc ()
[3]1 After releasing reser | this condition ran be changed only by
instmetion.
18 VEE Eowrer WEE i conmeried by e same vollage.
19 A Eack Lght anode
20 K Back-Light cathode
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7.7 — Serial EEPROM

The AT24C01A/02/04/08/16 provides 1024/2048/4096/8192/16384 bits of serial electrically
erasable and programmable read-only memory (EEPROM) organized as 128/256/512/1024/2048
words of 8 bits each. The device is optimized for use in many industrial and commercial

applications where low-power and low-voltage operation are essential.

Features of AT24Cxx:
Internally Organized 128 x 8 (1K), 256 x 8 (2K), 512 x 8 (4K)

2-wire Serial Interface

Bi-directional Data Transfer Protocol
100 kHz (1.8V, 2.5V, 2.7V) and 400 kHz (5V) Compatibility

Write Protect Pin for Hardware Data Protection

8-byte Page (1K, 2K), 16-byte Page (4K, 8K, 16K) Write Modes
— Data Retention: 100 Years.

I2C EEPROM XC35200-pins Serial EEPROM
% SDA P97
é AT24XX
N SPARTAN3 »| EEPROM
e ScL P98 l
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7.8 - Real Time Clock (DS1307)

The Real Time Clock (RTC) is a set of counters for measuring time when system power is on, and
optionally when it is off. It uses little power in Power-down mode. On the LPC2148, the RTC can
be clocked by a separate 32.768 KHz oscillator, or by a programmable prescale divider based on
the VPB clock. Also, the RTC is powered by its own power supply pin, VBAT, which can be
connected to a battery or to the same 3.3 V supply used by the rest of the device.

Features

e Measures the passage of time to maintain a calendar and clock.

o Ultra Low Power design to support battery powered systems.

e Provides Seconds, Minutes, Hours, Day of Month, Month, Year, Day of Week, Day of Year.
o Dedicated 32 kHz oscillator or programmable pre-scalar from VPB clock.

o Dedicated power supply pin can be connected to a battery or to the main 3.3 V.

I2C RTC XC35200 Real Time Clock

SDA P97
RTC
SPARTAN3 »| Ds1307
SCL P98

DS1307
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VLSI LAB Examples

(L-Scheme)
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SIMULATION OF VHDL CODE FOR COMBINATIONAL CIRCUIT

(Sum of Product) 1A
Description
Optimize a 4 variable combinational function (SOP or POS), describe it in VHDL code and
Simulate it.

Example: F= (0, 5, 8,9, 12) in sop

Truth Table for Sum of Product Simplification

A |B |C D|Y Sum of Product
0O |0 |0 |O |1 A’B’C’D’
0O |0 |0 |1 (O

0O |0 |1 |0 (O

0O |0 |1 |1 |0

0O |1 |0 |0 (O

0 1 0 1 1 A’BC’D
0O [1 |1 |0 (O

0 1 1 1 0

1 0 0 0 1 AB’C’D’
1 0 0 1 1 AB’C’D
1 /0 |1 |0 |O

1 |0 |1 |1 |0

1 1 0 0 1 ABC’D’
1 |1 (0 |1 |O

1 1 1 0 0

1 1 1 1 0

Boolean Expression:

Y =  AB’C’D'+A’BC’D+AB’C’D’+AB’C’D+ABC’D’
Y = B’C’D’(A’+A) +C’(A’BD+AB’D+ABD’)
Y = B’C’D’+A’BC’D+AB’C’D+ABC’D’
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Flow Chart ( >
Start

A 4
Initialize
Entity

»

|\

SET input A

A\ 4
SET input B

\ 4
SET input C

|

SET input D

]
\ 4

Output Y

y

End

34 | PANTEck soLUTiONY’ www.pantechsolutions.net L-scheme VLS| Lab Manual

Technology Bevond the Dreams



Code Listing
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Input Waveform

We give input a=high in waveform window

End Time:
1000 ns il ns 160 ng 280 ns 260 ns 440 ns 8480 ng B50 ns 780 ng 250 ns 450 ns

Lo oot bbb trr o brrr bl
M

ans
an:
and
Ay

A A

Output waveform

Finally we get output in simulation window(y=high according to that SOP Equation)

Now:
1000 ns 0ns 200 400 ns 600 800 ns 100

oL K
Mo

o
Hy

o
- o o o —
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SIMULATION OF VHDL CODE FOR COMBINATIONAL CIRCUIT

(Product of Sum) 1 B
Description
Optimize a 4 variable combinational function (POS), describe it in VHDL code and
Simulate it.

Y

Example: F= (0, 5, 8, 9, 12) in POS.

Truth Table for Product of Sum Simplification

A |B |C D|Y Product of Sum
0O |0 |0 |O |1

0O |0 |0 |1 (O A’+B’+C’+D
0O |0 |1 |0 (O A’+B’+C+D’
0O |0 |1 |1 |0 A’+B’+C+D
0O |1 |0 |0 (O A’+B+C’+D’
o (1 |0 |1 |1

0O [1 |1 |0 (O A’+B+C+D’
0 1 1 1 0 A’+B+C+D
1 /0 |0 |0 |1

1 /0 (0 |1 |1

1 |0 (1 |0 |O A+B’+C+D’
1 0 1 1 0 A+B’+C+D
1 |1 (0 |0 |1

1 1 0 1 0 A+B+C’+D
1 1 1 0 0 A+B+C+D’
1 1 1 1 0 A+B+C+D

(A’+B’+C’+D ) (A’+B’+C+D’) (A’+B’+C+D) (A’+B+C’+D’) (A’+B+C+D’)

(A’+B+C+D) (A+B’+C+D’) (A+B’+C+D) (A+B+C’+D) (A+B+C+D’) (A+B+C+D)
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Flow Chart

( Start )

A 4
Initialize
Entity

SET input A

A\ 4
SET input B

\ 4
SET input C

|

SET input D

]
\ 4

Output Y

y

End
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Code Listing
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Input Waveform

We give input a=high in waveform window

End Time:
1000 ns 50 ns 150ns  250ns  350ns  450ns  550ns  B50ns  750ns  B50ns  B50ns

Love v b br o trvo bbbt bt
ana

o
o o o o =

Output waveform

Finally we get output in simulation window(y=high according to that POS Equation)

Now:
1000 ns ln ns zoln 4on| ns 600 800 ns 100

oL K
b
e
M
Hy

- o o o —
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SIMULATION OF VHDL CODE FOR ARITHMETIC CIRCUITS 2

Description

Design and Develop the circuit for the following arithmetic function in VHDL Codes and
Simulate it. Addition, Subtraction Multiplication (4 x 4 bits)

2.1 — Addition (Program for 4-bit addition using 4 bit Ripple adder)
It is possible to create a logical circuit using multiple full adders to add N-bit numbers. Each full

adder inputs a Ci,, which is the C, of the previous adder. This kind of adder is called a ripple-
carry adder, since each carry bit "ripples” to the next full adder.

Initial carry-in C.l. Sum I Sumpg
Ay a1
B C.0.
Ay |
I— C.l. Sum —PSU“’H
Az a +
B c.0.
A
B, | I— c.l. Sumfp——— Sumg,
~+
E-1 | B C.0. _I
-— ey
At
B: B c.of—»Final Carry-out
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Full Adder
The full-adder circuit adds three one-bit binary numbers (Cin, A, B) and outputs two one-bit
binary numbers, a sum (S) and a carry (Cout).

B11 E] y—5
Cin

Cout

Flow Chart

SET input A

v
SET inputB

v
Verify output Y
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Code:

library IEEE: N
use [EEE.STD_LOGIC_1164.ALL;

use [EEE.STD_LOGIC_ARITH.ALL;
use [EEE.STD_LOGIC_UNSIGNED.ALL;

entity adder is
Port (x:in STD_LOGIC_VECTOR (3 downto 0);
y :in STD_LOGIC_VECTOR (3 downto 0);
cin:in STD_LOGIC;
sum : out STD_LOGIC_VECTOR (3 downto 0);
cout: out STD_LOGIC);
end adder;

architecture Behavioral of adder is

component fulladder
port(
X,y,cin:in std_logic;
sum,cout: out std_logic);
end component;
signal c: std_logic_vector(2 downto 0);

begin
al:fulladder port map(x(0), y(0), cin, sum(0), c(0));
az2:fulladder port map(x(1), y(1), ¢(0), sum(1), c(1));
a3:fulladder port map(x(2), y(2), ¢(1), sum(2), c(2));
a4:fulladder port map(x(3), y(3), ¢(2), sum(3), cout);
end Behavioral;
library ieee;
use ieee.std_logic_1164.all;
entity fulladder is
port(
X,y,cin:in std_logic;
sum,cout: out std_logic);
end fulladder;
architecture comb of fulladder is
begin
Sum <= X XOry Xxor cin;
cout <= (x and y) or (cin and (x xor y));
end comb;
43 | PARTECE SOLUTIONY’ www.pantechsolutions.net L-scheme VLSI Lab Manual

Technology Bevond the Dreams



Input Wave form

We give input x="1", y="1" and cin="1"in waveform window

End Time
1000 ns

&l cin

A cout

i {30

R ¥[3:0]

Q¥ sum[3:0]

50 ns 140 ns

240 ns
|

350 ns 450 ns 850 ns
[ B

640 ns

Talns 850 ns 950 n=
[ N

Output Wave form

We give input x="1", y="1" and cin="1" so we get sum="3’waveform window

Now:
1000 ns |n hs zTu 400 hs ETD 800 ns
| | | | | I | | | |
B30 1 ¢ i
@ [30] 1 ¢ i W 1
Mcin 1
@ sum(3:0] G D ¢ 3
& cout 0
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2.2- Subtraction (Program for 4-bit subtraction using arithmetic operator)

It is possible to create a logical circuit using multiple full subtractor to subtract N-bit numbers.
Each full subtractor inputs a Bi,, which is the By of the previous subtractor . This kind of
subtractor is called a ripple-carry subtractor, since each Borrow bit "ripples" to the next full
subtractor.

B3 B2 B1 BO
Bin A Bin A0

[ ] L1

FS 3 F5 2 F§& 1 Ff 0

Single connection

T between subtractors, so
| | | | if, for e.g. AO-BO = 0-1,
B out B out B out B out then FSO can borrow
from FS1 via this
connection, but cannot
D3 D2 D1 Do borrow from FS2 if A1
also happens to be 0.

Full Subtractor
A combinational circuit which performs the subtraction of three input bits is called full
subtractor. The three input bits include two significant bits and a previous borrow bit.

'y
A o
: ) >
L ] 3 e,
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= Flow Chart

SETinput A

v
SET inputB

v
Verify output Y
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Code Listing

ﬁbrary IEEE; \

use [EEE.STD_LOGIC_1164.ALL;
use [EEE.STD_LOGIC_ARITH.ALL;
use [EEE.STD_LOGIC_UNSIGNED.ALL;

entity sub is
Port (a:in STD_LOGIC_VECTOR (3 downto 0);
b:in STD_LOGIC_VECTOR (3 downto 0);
bin : in STD_LOGIC;
Diff : out STD_LOGIC_VECTOR (3 downto 0);
bout : out STD_LOGIC);
end sub;

architecture Behavioral of sub is
component fullsub
port(
a,b,bin:in std_logic;
Diff,bout: out std_logic);
end component;
signal D: std_logic_vector(2 downto 0);
begin
in, Diff(0), D(0));
(0), Diff(1), D(1))
(1), Diff(2), D(2))
(2), Diff(3), Bout);

O O T T
NN SN TS
W N - O
—— — —
O 0O O T

end Behavioral;

library ieee;
use ieee.std_logic_1164.all;

entity fullsub is
port(
a,b,bin:in std_logic;
Diff,bout: out std_logic);
end fullsub;

architecture comb of fullsub is

begin

Diff <= a xor b xor bin;

bout <= ((nota )and b) or ((not bin )and (a xor b)) ;

\end comb; )
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Input Waveform
We give input a="1010’, b="0101" in waveform window

End Time: a0 140 250 350 450 550 Ba0 740 850 950
ns ns ng ng ns ng ng ns ns ng

1000 ns T T e o o
N bin 0

M bout 0
H EX:a[B:D] 4'b1...< 401010
b bl3:0] ELTIN 4'h0000 b 4p01m
¥ Diff[3:0) T ¢ I
Output Waveform

We get output in simulation window( according to that subtraction Operation)
Now:
1000 ns |D ns ETD 4DD| ns GTD SDD| ns 1000
L1 | | L1 | | | |

@ al30) LT 10
@ b[30] 5 { i I g

M bin 0
E @ diff3:0] I 14 b 5

2 diff3] 0 |

N diff[2] 1

AN diff1] 0 |

AN dififo] 1 |

M bout 0 |
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2.3 — Multiplication (Program for simple 4x4 multiplications using arithmetic operator)

Consider the multiplication of two numbers as 4 x4 a * b, where a and b are 4 bit numbers and
the output of multiplication is taken in y as 8 bit number.

= Flow Chart

SETinput A

v
SET input B

v
Verify output Y
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Code Listing

(library IEEE;

use [EEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use [EEE.STD_LOGIC_UNSIGNED.ALL;

entity codef is
Port(a:in STD_LOGIC_VECTOR (3 downto 0);
b:in STD_LOGIC_VECTOR (3 downto 0);
y :out STD_LOGIC_VECTOR (7 downto 0));
end codef;

architecture Behavioral of codef is
begin

y<=a*b;
end Behavioral,

. .
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Input Waveform

We give inputa="2’&b ="2".

End Time:
a0 ns 180 ns 280 ns 350 ns 480 ns 550 ns 650 ns Talns 850 ns
1000 ns Lol ol b r b r o b bl
5 i a[2:0] 2 ¢ i W 2
5] Gl b[3:0] 2 i i b 7
5 Gl virn) T ¢ 0
Output Waveform

We give inputa="2"& b ="2’ .s0, we get output y="4" according to that multiplication
operation.

Now:
1000 ns |n ns o zTn o 400 ns o B0D o ann| ns o 1000
& alEn A T 2
b0 2 0 X 2
By 4 0 b 4
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SIMULATION OF VHDL CODE FOR MULTIPLEXER 3

Description

Design and develop a 2 bit multiplexer and port map the same for developing up to 8 bit
multiplexer.

Multiplexer

A multiplexer is a combinatorial circuit that is given a certain number (usually a power of two)
data inputs, let us say 2", and n address inputs used as a binary number to select one of the data
inputs. The multiplexer has a single output, which has the same value as the selected data input.

In other words, the multiplexer works like the input selector of a home music system. Only one
input is selected at a time, and the selected input is transmitted to the single output. While on the
music system, the selection of the input is made manually, the multiplexer chooses its input based
on a binary number, the address input.

The truth table for a multiplexer is huge for all but the smallest values of n. We therefore use an
abbreviated version of the truth table in which some inputs are replaced by "-' to indicate that the
input value does not matter.

Here is such an abbreviated truth table forn = 3. The full truth table would have 2C * 23 =
2048 rows.
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2:1 mux to construct 8:1 mux

o}
I

3

I

i

[~]=] (=]

Flow chart

START

Initialize
Entity

S

Read A, B, SELECT &
ENABLE
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Code Listing

2:1 multiplexer program

library IEEE; N
use IEEE.STD_LOGIC_1164_ALL;
use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;
-——- Uncomment the following library declaration if instantiating
-——- any Xilinx primitives in this code.
—-—library UNISIM;
—--use UNISIM.VComponents.all;
entity mux is
Port ( x - in STD_LOGIC;
y : in STD_LOGIC;
sel - in STD_LOGIC;
z - out STD LOGIC);
end mux;
architecture Behavioral of mux is
begin
process (X,y,sel)
begin
if(sel="0") then
Z<=X;
elsif (sel="1") then
Z<=y;
end if;
\Snd process; Y,
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8:1 mux port map program

/i}brary 1EEE;

use IEEE.STD_LOGIC_ 1164 _ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

—-——- Uncomment the following library declaration if instantiating
-——- any Xilinx primitives in this code.

—-—library UNISIM;

—--use UNISIM.VComponents.all;

entity multiplexer is
Port (
a, b,c,d,e,f,g,h - in STD_LOGIC ;
c0,cl,c2: in std_logic;
z - out STD _LOGIC );

end multiplexer;

architecture Behavioral of multiplexer is
component mux

port(

Xx:in std_logic;

y: in std_logic;

sel: in std_logic;

z: out std logic

)

end component ;

signal z1,z2,z3,z4,z5,z6 : std_logic :="0%;
begin

signal z1,z2,z3,z4,z5,z6 : std_logic ::="0";

begin
muxl: mux port map (a, b, cO, zl);
mux2: mux port map (c, d, cO, z2);
mux3: mux port map (e, f, cO, z3);
mux4 mux port map (g, h, cO, z4);
mux5: mux port map (zl1, z2, cl, z5);
mux6: mux port map (z3, z4, cl, z6);
mux7: mux port map (zb5, z6, c2, z);

end Behavioral;

&
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Input Waveform

We give input a="high’ in waveform window

End Time:
1000 ns

=
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Output Waveform

We get output in simulation window (y="high’ according to that multiplexer operation)

End Time:
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SIMULATION OF VHDL CODE FOR DEMULTIPLEXER 3

Description
Design and develop an 8 output demultiplexer using truth table.

Demultiplexer

The demultiplexer is the inverse of the multiplexer, in that it takes a single data input and n
address inputs. It has 2" outputs. The address input determine which data output is going to have
the same value as the data input. The other data outputs will have the value O.

Here is an abbreviated truth table for the demultiplexer. We could have given the full table since
it has only 16 rows, but we will use the same convention as for the multiplexer where we
abbreviated the values of the data inputs.

S2 S1 SO E Y7 Y6 Y5 Y4 Y3 Y2 Y1 YO
0 0 0 1 0 0 0 0 0 0 0 1
0 0 1 1 0 0 0 0 0 0 1 0
0 1 0 1 0 0 0 0 0 1 0 0
0 1 1 1 0 0 0 0 1 0 0 0
1 0 0 1 0 0 0 1 0 0 0 0
1 0 1 1 0 0 1 0 0 0 0 0
1 1 0 1 0 1 0 0 0 0 0 0
1 1 1 1 1 0 0 0 0 0 0 0

Here is one possible circuit diagram for the demultiplexer:

In this program a 1 x 8 de-multiplexer have two 1- bit inputs, a 3-bit select line and a 8- bit
output. Additional control signals may be added such as enable. The output of the multiplexers
depends on the level of the select line.
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Flow Chart

Initialize
Entity

P

WhenA & B="0’
IN = Out0

A 4

WhenA='0'&B="1’
IN=0utl

v

WhenA =1 &B="0’
IN = Out2

\ 4

WhenA='1&B="1
IN = Out3
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Code Listing

library ieee;
use ieee.std logic_1164.all;

entity demultiplexer is
port(l : in std _logic;

s - in std_logic vector(0 to 2);

0 : out std_logic_vector(0 to 7));
end demultiplexer;

architecture data of demultiplexer is

begin
0(0) and not s(0) and not s(1) and not s(2));
o) and s(0) and not s(1) and not s(2));
0(2) and not s(0) and s(1) and not s(2));
0(3) and s(0) and s(1) and not s(2));
o(4) and not s(0) and not s(1) and s(2));
0o(5) and s(0) and not s(1) and s(2));
0(6) and not s(0) and s(1) and s(2));
o) and s(0) and s(1) and s(2));

end data;
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Input Waveform

We put enable as high in all condition and here we give input="010" in selection
line(according to that selection line we get output)

End Time:
1000 ns 100 ng 3DD| ns 500| ns ?IJD| ns 900 ns
I [ [ [ |
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@ gyioT) ¢ 0
Output Waveform

We get output in simulation window(according to that selection line)

Now:
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VHDL IMPLEMENTATION OF MULTIPLEXER

Description

Describe the code for a multiplexer and implement it in FPGA kit in which switches are

connected for select input and for data inputs a LED is connected to the output.

Flow Chart

START _

Initialize
Entity

=

Read A, B, SELECT &
ENABLE
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PIN Description:

I/0 Pins A B C D SELO SEL1 OUTPUT
FPGA LOC | P23 P26 p27 P28 P93 P105 P53
Code Listing

library ieee;

use ieee.std logic_1164.all;

use ieee.std _logic_arith.all;
use ieee.std_logic_unsigned.all;

entity mux_gate is

port (A,B,C,D: in STD_LOGIC;
SEL : in STD_LOGIC vector (1 downto 0);
Output : out STD_LOGIC);

end mux_gate;

architecture behav of mux_gate is
begin

process (SEL,A,B,C,D)

begin

case SEL is

when "00" => Output <= A;
when "01" => Output <= B;
when "10" => Output <= C;
when "11" => Output <= D;
when others => null;

end case;
end process;
end behave;
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VHDL IMPLEMENTATION OF DEMULTIPLEXER

Description

output of the circuit.

Flow Chart

Initialize
Entity

Q

WhenA & B="0’
IN = Out0

WhenA='0'&B="1"
IN=0utl

A 4

WhenA =1 &B="0’
IN = Out2

\ 4

WhenA='1&B="1
IN = Out3

Switches are connected for select inputs and a data input, Eight LEDs are connected to the

L-scheme VLSI Lab Manual
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PIN Description:

I/0 PINS

E SO [s@ [s@ [YO) [Y@)

YQ)

Y3)

Y(4)

YG) [Y(6) 1Y)

FPGA LOC

P23 | P33 | P93 | P105 | P53 | P50

P24

P23

P21

P20 | P18 | P17

Code Listing

library ieee;
use ieee.std logic_1164.all;

entity demultiplexer is
port(e : in std _logic;
s - in std_logic vector(0 to 2);

y : out std_logic_vector(0 to 7));

end demultiplexer;
architecture data of demultiplexer is

begin

y(0) <= (e and not s(0) and not s(1) and not s(2));
y(1) <= (e and s(0) and not s(1) and not s(2));
y(2) <= (e and not s(0) and s(1) and not s(2));

y(3) <= (e and s(0) and s(1) and not s(2));

y(4) <= (e and not s(0) and not s(1) and s(2));

y(5) <= (e and s(0) and not s(1) and s(2));
y(6) <= (e and not s(0) and s(1) and s(2));

y(7) <= (e and s(0) and s(1) and s(2));

end data;
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VHDL IMPLEMENTATION OF 7 SEGMENT DECODER

Description

Develop Boolean expression for 4 input variables and 7 output variables. Design and develop
seven segment decoder in VHDL for 7 equations. A seven segment display is connected to the
output of the circuit. Four switches are connected to the input. The 4 bitinput is decoded to 7

segment equivalent.

Flow Chart

/ Initialize Entity  /

Enable Digit Selection
(Digit1- Digit4)

!

SWITCH TO 7 SEGMENT
DISPLAY
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PIN Description:

I/0 | CLK | 10 11 12 13 A B C D E F G SELO | SEL1 | SEL2 | SEL3
PINS
FPGA | P55 | P32 | P33 | P93 | P105 | P129 | P130 | P131 | P132 | P135 | P137 | P140 | P124 | P125 | P127 | P128
LoC
Look Up Table:

13 12 11 10 G F E D C B A

0 0 0 0 1 0 0 0 0 0 0

0 0 0 1 1 1 1 1 0 0 1

0 0 1 0 0 1 0 0 1 0 0

0 0 1 1 0 1 1 0 0 0 0

0 1 0 0 0 0 1 1 0 0 1

0 1 0 1 0 0 1 0 0 1 0

0 1 1 0 0 0 0 0 0 1 0

0 1 1 1 1 1 1 1 0 0 0

1 0 0 0 0 0 1 1 0 0 0
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Code Listing

X0<=
X1<=
X2<=
X3<=
X4<=
X5<=
X6<=
X7<=
X8<=
X9<=

A <=
B <=
C <=
D <=
E <=
F <=
G <=
e

(NOT
(NOT
(NOT
(NOT
(NOT
(NOT
(NOT
(NOT

library IEEE;
use IEEE.STD _LOGIC 1164 .ALL;

entity seven_seg is
Port ( 13,12,11,10 : in STD _LOGIC;

sel : out std logic_vector (3 downto 0);

-— Uncomment the following library declaration if
instantiating

-— any Xilinx primitives in this code.
-—library UNISIM;

--use UNISIM.VComponents.all;

A,B,C,D,E,F,G - out STD _LOGIC);

13
13
13
13
13
13
13
13

(13 AND
(13 AND

X1 OR
X5 OR
X2;

X1 OR
X1 OR
X1 OR
X0 OR

end seven_seqg;

AND
AND
AND
AND
AND
AND
AND
AND
NOT
NOT

X4 ;
X6;

X4 OR
X3 OR
X2 OR
X1 OR

nd Behavioral;

architecture Behavioral of seven seg is

SIGNAL X0,X1,X2,X3,X4,X5,X6,X7,X8,X9:STD_LOGIC;
begin

sel <= "11111111";

NOT 12 AND NOT 11 AND NOT 10);
NOT 12 AND NOT 11 AND 10);

NOT 12 AND 11 AND NOT 10);

NOT 12 AND 11 AND 10);

12
12
12
12
12
12

X7
X4
X3
X7;

AND NOT 11 AND NOT 10);
AND NOT 11 AND 10);
AND 11 AND NOT 10);
AND 11 AND 10);

AND NOT 11 AND NOT 10);
AND NOT 11 AND 10);

OR X9;
OR X5 OR X7 OR X9;
OR X7;

-- Uncomment the following library declaration if using
-— arithmetic functions with Signed or Unsigned values
--use IEEE.NUMERIC_STD.ALL;
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VHDL IMPLEMENTATION OF 7 SEGMENT DECODER BY LUT 8

Description

Develop a 7 segment decoder using Look up table. Describe the seven segment decoder in VHDL
using developed Look up table. A seven segment display is connected to the output of the circuit.
Four switches are connected to the input. The 4 bitinputis decoded into 7 segment equivalent.

Flow Chart

/ Initialize Entity  /

Enable Digit Selection
(Digit1- Digit6)

) 4

A 4

SWITCH TO 7-SEGMENT
DISPLAY
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Look Up Table:

13 12 11 10 G F E D C B A

0 0 0 0 1 0 0 0 0 0 0

0 0 0 1 1 1 1 1 0 0 1

0 0 1 0 0 1 0 0 1 0 0

0 0 1 1 0 1 1 0 0 0 0

0 1 0 0 0 0 1 1 0 0 1

0 1 0 1 0 0 1 0 0 1 0

0 1 1 0 0 0 0 0 0 1 0

0 1 1 1 1 1 1 1 0 0 0

1 0 0 0 0 0 1 1 0 0 0

PIN Description:

/0 | CLK | IO 11 12 13 A B C D E F G SELO | SEL1 | SEL2 | SEL3
PINS
FPGA | P55 | P32 | P33 | P93 | P105 | P129 | P130 | P131 | P132 | P135 | P137 | P140 | P124 | P125 | P127 | P128
LoC
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Code Listing

library 1EEE;

Port (I : in

end SEVEN_SEG_LUT;

begin

SEL <= "1111';
process (1)
BEGIN

case 1 is
when "0000"'=>
when "0001''=>
when "0010"'=>
when *0011"'=>
when "0100"'=>
when ""0101"'=>
when *"0110"'=>
when ""0111"'=>
when "1000"'=>
when *1001"'=>
when others=>
end case;

< <K<K <K<K <K<K<K<K<KK
A
1]

end process;

end Behavioral;

use IEEE.STD_LOGIC_1164.ALL;

entity SEVEN SEG_LUT is

STD_LOGIC_VECTOR (3 downto 0);

architecture Behavioral of SEVEN SEG LUT is

"1000000"; -- *"O"
"1111001"; -- *"1°
"0100100"; -- *"2¢
"0110000"; -- *"3"
"0011001"; -- "4°
"0010010"; -- *"5°¢
"0000010™; -- "6"
"1111000"; - *7°"
"0000000™; -- *"8"
"0011000"; -- "9°
"1111111";

SEL : out STD_LOGIC_VECTOR (7 downto 0);
Y - out STD LOGIC VECTOR (6 downto 0));
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VHDL IMPLEMENTATION OF ENCODER 9

Encoder:
Design and develop HDL code for decimal (Octal) to BCD encoder. There will bel0 input switches (or
8 switches) and 4 LEDs in the FPGA kit. The input given from switches and it is noted that any one of

the switch is active. The binary equivalent for the corresponding input switch will be glowing in the
LED as output

Logical Diagram
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Flow Chart

/

Initialize
Entity

v

Read input lines

IF

Inout = 000

Output =00

v

IF

Inout=0010 .~

Output =01

!

IF

Inbut=0100_—"

Output =10

Inobut=1000_~

IF

Output=11
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PIN Description:

/0 [ X@A) [ X2 [X@) [ X@) [X(5) [X6) [ X(7) [X@®) [X© [A [B [C [D
PINS

FPGA | P105 | P93 | P33 | P32 | P31 | P30 | P28 | P27 | P26 |P53 |P50 |P24 |P23
LoC

Code Listing

library 1EEE;

use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity first is

port ( x : in std_logic_vector(9 downto 1);
a,b,c,d : out std_logic;);

end first;

architecture Behavioral of first is

begin

a<= x1 or x3 or x or X7 or x9;
b<= x2 or x3 or x6 or X7 ;

c <= x4 or x5 or x6 or X7 ;
d<= x9 or x8 ;

end Behavioral;
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SIMULATION OF VHDL CODE FOR DELAY

10

Description

Develop a VHDL code for making a delayed output for 1second or 2 seconds by assuming clock
frequency provided in the FPGA Kit. Simulate same code to get a delayed waveform.

Flow Chart

/ Initialize Entity

SET input clock

\ 4
Delay for 1sec

( END )

<Y
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Code Listing

ibrary IEEE; I
use IEEE.STD LOGIC 1164.ALL;
use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity First is
port ( clock : in std _logic;
a : out std_logic

o/

end First;
architecture Behavioral of first is

begin

process(clock)

variable i : integer := 0;
begin

ifT clock®event and clock
if 1 <= 50000000 then

i =1 +1;

a <= "1";

elsift 1 > 50000000 and i < 100000000 then
i =1 +1;

a <= "0";

elsif 1 = 100000000 then

"1" then

end process;
end Behavioral;
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Input Waveform

We give input in waveform window (clk="1")

End Time:
1000 ns 1DD| ns | | ‘ SDD| ns | | | SDD| ns | | | TDDl ns | Qool ns |
AN clock 0 4 | | | | | | |
Ma 0
Output Waveform

We get output in simulation waveform (a="delayed signal’)

Now:
1200 ns Ons 240 480 ng 720 960 ns 120
Y ey T [ | [
M clock 1 | | | | | | | | |
Ma 11—
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VHDL IMPLEMENTATION FOR BLINKING A LED 1 1

Description

Develop a VHDL Code for delay and verify by simulating it. This delay output is connected to LED.
Delay is adjusted such away LED blinks for every 1 or 2 seconds.

Flow Chart

Initialize
Entity

I

SETLED high

v

Delay for 250ms

v

SET LED low

v

Delay for 250ms

A

oD
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PIN Description:

I/0 PINS CLK LED
FPGA LOC P55 P53
Code Listing

/?ibrary 1EEE;

use IEEE.STD_LOGIC_1164_ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity First is
port ( clock : in std _logic;

LED : out std_logic);
end First;

architecture Behavioral of first is

begin

process(clock)

variable 1 : integer := 0;
begin

if clock"event and clock = "1 then
!f i <= 50000000 then

i =1 + 1;

LED <= “07;

elsift 1 > 50000000 and i < 100000000 then
i =1 + 1;

LED <= “17;

elsif 1 = 100000000 then

i := 0;

end if;

end if;

end process;
end Behavioral;

&
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SIMULATE A VHDL TEST BENCH CODE FOR TESTING A GATE 12

Description
Develop a VHDL test bench code for testing any one of the simple gate. Simulate the test bench

code in the HDL software.

Flow Chart

/ Initialize Entity

SET input clock

\ 4
Delay for 1sec

( END )

<Y
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Code Listing (AND gate program)

‘library IEEE;

use IEEE.STD LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity gate is
Port ( a : in STD_LOGIC;
b : in STD_LOGIC;
c : out STD_LOGIC);
end gate;

begin
Cc <= a and b;

end Behavioral;

architecture Behavioral of gate is
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Testbench code

LIBRARY ieee;

USE ieee.std_logic_1164_ALL;
USE ieee.std_logic_unsigned.all;
USE ieee.numeric_std.ALL;

ENTITY code_vhd 1S
END code_vhd;

ARCHITECTURE behavior OF code vhd IS

—-— Component Declaration for the Unit Under Test (UUT)
COMPONENT cd

PORT(

a - IN std_logic;

b : IN std_logic;

c - OUT std logic

)
END COMPONENT;
--Inputs
SIGNAL a : std_logic := "07;
SIGNAL b : std_logic := "07;
-—Outputs

SIGNAL ¢ : std logic;
BEGIN

-- Instantiate the Unit Under Test (UUT)
uut: cd PORT MAP(

a => a,
b => b,
c =c
)
tb : PROCESS
BEGIN
a<="1";
b<="1"-

-— Wait 100 ns for global reset to finish
wait for 100 ns;

a<="1""

b<="0" -

-- Place stimulus here

wait for 100 ns; -- will wait forever
END PROCESS;

END;

AN /
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Output Waveform

We get output in simulation window (c="1" according to that gate operation)

Now:
1000 ns |D ns 200 400 ns 600 800 ns 1004
I I L1 L1 L1
aa 1
o U s N S D e D e D
e A S I R I R S T S
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VHDL IMPLEMENTATION FOR BLINKING A ARRAY OF LEDS 13

Description

Design and develop a VHDL Code for 4 bit binary up counter. Four LEDs are connected at the output
of the counter. The counter should up for every one seconds.

Flow Chart

/ Initialize Ent|ty fﬂ:ﬁ

Enable Clock

\ 4
Counter
Value Increase from
(0to 15)
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PIN Description:
I/OPINS | CLOCK | RST | Q(3) | Q(2) | Q(1) | Q(0)
FPGA LOC | P55 P23 | P23 | P24 | P30 | P33

g Code Listing

(iibrary 1EEE; )
use IEEE.STD_LOGIC_1164.ALL;

use IEEE.STD_LOGIC_ARITH.ALL;

use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity First is
port ( clock : in std_logic;
rst:in std_logic;
q : out std_logic_vector(3 downto 0)
)

end First;

architecture Behavioral of Ffirst is
signal tmp: std_logic_vector(3 downto 0):="0000";

begin

process(clock ,rst)
variable i : integer := O;
begin

if (rst="1") then

tmp <= "0000";

elsifT clock"event and clock = "1" then
if 1 <= 50000000 then

i =1 + 1;
elsift 1 = 50000001 then
i :=0;
thp <= tmp+1;
end if;
end if;
end process;
g<= tmp;
end Behavioral;
\ J
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VHDL IMPLEMENTATION OF A SPELLER WITH AN ARRAY OF LEDS

14

Description

Design and develop VHDL Code for a 5 bit Johnson ring counter 4 bit The LEDs are connected at the

output of the counter. The speller should work for every one seconds.

Flow Chart

START

/ Initialize Entity ~ /

Enable Clock

\ 4
Value incerse
In ring order

PIN Description:

I/0 PINS CLOCK | RST | Q(4) | Q(3) | Q(2) | Q(1) | Q(0)

FPGA LOC | P55 P23 | P21 | P23 | P24 | P30 | P33
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Johnson Ring Counter

.

CLE CLK CLEK CLK
CLR CLR CLR CLR

R5T

CODE Listing

(;ibrary 1EEE;

use IEEE.STD_LOGIC_1164_ALL;

use IEEE.STD_LOGIC_ARITH.ALL;
use IEEE.STD_LOGIC_UNSIGNED.ALL;

entity first is
port ( clk : in std_logic;

Reset: in std logic;

output : out std_logic_vector(4 downto 0));
end first;

architecture Behavioral of first is
signal temp: std_logic_vector(4 downto 0):=700000";
begin

process(clk, Reset)

variable i,k : integer := O;

begin

if Reset = “1” then

temp <= “00000’;

elsif clk"event and clk = "1 then
if 1 < 50000000 then

i =1 +1;

elsit 1 = 50000000 then

temp(1l) <= temp(0);

temp(2) <= temp(l);

temp(3) <= temp(2);

temp(4) <= temp(3);

temp(0) <= not temp(4);

1:=0;

end if;

end if;

end process;

Reset <= temp;

End Behavioral;

&

J
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VHDL IMPLEMENTATION OF 7 SEGMENT DISPLAY 15

Description

Design and develop a seven segment decoder in VHDL. Design and develop a 4 bit BCD
counter, the output of the counter is given to seven segment decoder. A seven segment display
is connected to the output of the decoder. The display shows 0,1, 2.. 9 for every one second

Flow Chart

/ Initialize Entity  /’

Enable Digit Selection
(Digit1- Digit6)

A 4

Display Message
‘000000’ —‘FFFFFF’

C END )

PIN Description:

/0 [CLK]Y() |[Y@) [Y(@ [YB) [Y@ [Y() |Y(6) |Y(7) |SELO | SELL | SEL2 | SEL3
PINS

FPGA | P55 | P129 | P130 | P131 | P132 | P135 | P137 | P140 | P141 | P124 | P125 | P127 | P128
LoC
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Code Lisitng

( )
library ieee;

use ieee.std logic_1164.all;

use ieee.std_logic_arith.all;

use ieee.std _logic_unsigned.all;

entity object co 1is

port(clk : in std logic;
y : out std_logic_vector(7 downto 0);
sel : out std_logic_vector(7 downto 0)
);

end object co;

architecture beav of object co is
type state is
(stateO,statel,state2,state3,state4,state5, state6,state7,state8,
state9);

signal next_state,ps: state := stateO;
begin

sel <= "11111111";
process(clk,next_state)

variable i : integer := 0 ;

begin

if clk*event and clk = 1" then

if 1 <= 100000000 then

i =1 + 1;

elsift 1 > 100000000 then
i :=0 ;

next _state <= ps ;

end if;

if next _state = state0 then

y <= X"c0" ;

ps <= statel;

elsif next_state = statel then
y <= x"f9";

ps <= state2;
elsif next_state
y <= X"a4";

ps <= state3;
elsif next_state
y <= X"b0";

state2 then

state3 then

\. J
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4 )
ps <= state4;

elsif next _state = state4 then
y <= X'99";

ps <= state5;

elsif next _state = stateb5 then
y <= X"92";

ps <= state6;

elsif next_state = state6 then
y <= X"82";

ps <= state7;

elsif next _state = state7 then
y <= X"f8";

ps <= state8;

elsif next _state = state8 then
y <= X"80";

ps <= state9;

elsif next _state = state9 then
y <= X'98";

ps <= stateO;

end if;

end if;

end process;

end beav;

L S
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Getting Started with Xilinx ISE
(Tutorial)
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9 - Getting Started with Xilinx ISE

After installing Xilinx ISE 8.1 i software, go to Start menu

Start =»Programs = Xilinx ISE 8.1 i =» Project Navigator (or) double click desktop icon

(refer Figure-1). A Window shown in Figure-2 will appear.

=i
@ Set Program Access and Defaults = HiimcISE . B8 Accessories

B Windows Catalag @ Divi E Documentation

& windows Update [E8 Mero 7 Essentials =

@ WinZip @ SuperCopier2 D Readme

K #-HoLs B8 Padks @ Software Update Center
@ ModelSim SE 5,6 Evaluation

B3 %-Tek

Keil uvision3

E avast! Antivirus

Arcessoties

7 K-Lite Codec Pack
% Internet Explorer E e Codac Pac

0; Outook Express [E8 Total video Converter

A acrobat,com

,, Remote Assistance
B8 adobe Reader o

e’. ‘Windows Media Player
il 3 Windows Messenger
a Windows Mavie Maker

Microsoft Office

= 50 FREE MP3s from eMusic!

?.!" Adobe ImageReady ©5

ﬂ Adobe Photoshop 5

wherLink DYD Solution

5va 2 Runfime Environment
v Web Start

G CDD Auto Firmware Updste
ero

urbo C++ 4.5

wherLink DYD Suite

) wiordieh
Realtek Sound Manager

0L Schaal Atlss 4] ) 10:56 PM

FIGURE -1
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Xilinx - ISE - G:\PSTYRO-FPGASP3WCODEEXA-Ja\EXA-Ja.ise

File Edit “iew Project Source Process Sindow Help

DRAHE L0 FFR @A AR £ XBE oo hi& EICERT=

No project is open

Select:
File-»Open Praject

or
File->Mew Project

E§ Souces | gl Snar 4 b

No flow available.

¥ untitled -, [BR i1, TS 1104 1

FIGURE - 2

Create a New Project

Create a new ISE project which will target the FPGA device on the Spartan-3 TYRO/PRIMER board.
To create a new project:

1. Select File = New Project... The New Project Wizard appears.(refer figure 3)
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Xilinx - ISE - G:WPSTYRO-FPGASPIWCODEIEXA-3a\EXA-Ja.ise

Edit WView Project Source Process Window Help

PR @YU AR AW XBR oo Mk Fl®meom 9

‘Open Project. ..

Open Example. .

Close Project

Save Project As...

[ Mew Chrl+N

B open... Ctl+O
Close

H sae Chil+5
Save As..

P savenll

G Print... Chrl+p
B Prink Preview. ..

Recent Files 3
Recent Projects 3

Exit

24 Processes

e unititled =, [BR wiirx - 1... ol
FIGURE 3
2. New Project wizard window shown in Figure -4 will appear. In the Name field, enter your project
name and enter the location where you want to create the project in the Location field (NOTE: don’t use
c drive or desktop). In the Top-Level Module select HDL and click Next (refer Figure-5).
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File Edit Yiew Project Source Process Window Help

DRPEHT LB EFR BUMLET AR 4% XBR oo Xk B =

Sources

x

Select:

ar

Mo project is open

File-» Open Project

File-»Mew Project

Processes

B8 Sources e Snar 4 b

New Project Wizard - Create New Project
X

~Enter a Name and Location for the Project

No flow available. Project Mame: Project Location

| [Eosiing

~Selectthe Type of Top-Level Source for the Project

Top-Level Source Type:

HOL

E—ﬁ:Pmcasses

x

Transcript

b

=
FIGURE 4
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Xilinx - ISE - G:\PSTYRO-FPGASPIICODE'EXA-Ja\EXA-Ja.ise

File Edit Wiew Project Source Process Window Help

DAEHS LD EFED BHHAANE AR A XRE o & Fl®mBEOD @

Sources x

No project is open

Select:
File-> Open Praject

or
File->Mew Project

g Sources sy Snag 4 *

New Project Wizard - Create New Project

Processes x

- ~Enter a Mame and Location for the Praject
No flow available. Project Mame: Project Location

[¢pDITION | [EEXEPERMIENT 15ADDITION

~Select the Type of Top-Level Source tar the Project -
Top-Level Source Type,
[HOL

ﬁ—# Processes

E [5] Conscle @ Evors | g\ Wamings | [ Find inFiles H
|caps.
B unbitled = B i - 1., i,
Figure 5
3. Awindow given in Figure-6 will appear. Fill in the properties in the table as shown below:
v Product Category: All
v' Family: Spartan3
v Device: XC35200
v' Package: TQ144 selected.
v' Speed Grade: -4
v" Top-Level Module Type: HDL
v Synthesis Tool: XST (VHDL/Verilog)
v Simulator: ISE Simulator (VHDL/Verilog)
Then click "Next" (refer Figure- 6, 7, 8) and then "Finish™ (refer Figure- 9).
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File Edit “iew Project Source Process Window Help

DPHI BEFD SAHLE N

Sources x

No project is open

Select:
File-» Open Project
ar
File->Mew Project

B Sources oA d b

Processes x

Mo flow available.

LR YBE B MK Flmeom @

New Project Wizard - Device Properties

-Select the Device and Design Flaw far the Project

Property Hame -

Yalue

Product Categary

Al

Family

Spartand

Device

35200

Package

TO144

Speed

4

Top-Level Source Type:

HOL

Synthesis Tool

%5T [VHDL Aferiing)

Simnulator -

ISE Simulator [VHDLA erilag]

Enable Enhanced Design Summary

O

E nable Message Filtering

O

Digplay Incremental Messages

O

Ef Processes

X

Transcript

E Canzale

FIGURE 6
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File Edit Wiew Project Source Process Window Help

Sources

No project is open

Select:
File-> Open Project
ar
File->Mew Project

B Sources g Snap 4 >

Processes x

No flow available.

DPHF GREFTR @AALL AR &4 XBE o KiE Fl=EO0m @
»

Hew Project Wizard - Create New Source

~Create a New Sourc

MHew Source...
Remorve-

Creating a new source to add to the project is optional. Only one new source can be created with the New Project ‘Wizard
Additional sources can be created and added to the project by using the "'Project->Mew S ource” command.

Esisting sources can be added on the nest page.

2f Prooesses

< Back H Mext > | { Cancel

x

Transcript

FIGURE 7
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Fe Edt Wew Feojedt Source Frocess ‘Window Heb

DPHO LR TP SXXAAX AR A% YRR we AR I 2500 ¢
Sources x

Ay enaing tounces it pbonal Addtional sunces can e ackded e the proect it ceeated wnrg e ProisctAdd
Seurce™ o Fropct niekd Copy ol Sourcs™ commands

i Procews L Mavine. | sbod [ otr ] [ Coed |

FIGURE 8
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Xilinx - ISE - G:'II’ST\"M-FI’GASPE'EODIélEXA-EIIEXA-SI.ise

File Edit Yiew Project Source Process ‘Window Help

Sources

No project is open

Select:
File-» Open Project

ar
File->Mew Project

CAHS LR EFR @AHYLNL AR & YR we aE_ 200 ¢
X

& L -
M wﬁne[ E New Project Wizard - Project Summary (N
Processes x
No flow available. Project Mavigatar will create a new project with the following specifications:
Project: S
Project Hame: ADDITICH
Froject Path: E:\EXEPERMIENTI\ADDITION
Top Level Source Type: HIDL
Device:
Device Family: Spartan3
Device: xe3z200
Package: toldd
Speed: -4
Synthesis Tool: XST (VHDL/Verilog)
Fimulator: ISE Simulator (VHDL/Verilog)
Enhanced Design Swmnary: dissbled
Message Filtering: disabled K.
2f Processes < Back Finish Cancel
o
" -
=t v
g [{ )
= Console | @ Enors |\ Wanings | [q Findin Files
CAPS
& fazwind., = M2Meoo., ~ By utited-. ' B winc-1... 50, 5 @ 1

FIGURE9

4. A window given in Figure-10 will appear. Select Project menu =» New Source (refer Figure-11). A
window given in Figure-12 will appear. Then select VHDL module, and specify the file name in
appropriate field as shown in figure-13 and Click Next. If you want you can give inputs & outputs in the
appropriate positions in the window shown in Figure -14.You can also skip these information by simply
clicking Next button and click Finish (refer Figure - 15).
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Xilirex - ISE - EAEXEPERMIENT1WADDITIONADDITION.ise

File Edit ¥iew Project Source Process Window Help

DPHF LB EFR BAALL AR L9 X2B v o M| mEOh @
[Souces ]

Sources for: | SynthesisAmpler
(] 4DDITION

o E we3s200-0tq144

B Sources g Snap 4

[ AddExisting Source
™ Cieate New Souce
& s‘ Design Utilites

Trans cript

A\ Warmings | [pg Firdin Files
CARS|
@2 wiro.. ~ Funttled-.. [E§ 2o, S @ 11o7em

Figure-10
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- ISE - E\EXEPERMIENT1\ADDITIONADDITION.ise

File Edit ‘Wiew Source Process MWindow Help

DR HEE

BAR AW XBB oo KK Fl2EDD

Add Source. ., Ins
Add Copy of Source...  Shift+ns

ADDITID Cleanup Project Files
- £ we3s200- Togagle Paths

Archive.,

Take Snapshat...

Make Snapshot Current
B} Sources

Apply Project Properties. ..
Processes: T

[ Add Existing Source
B Create New Source
& w Design Utilties

.'.ﬁ wind... « (0 w0 untited - B winc- 1., a{.g:”

Figure-11
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RMIERT1\ADDITION\ADDIT]

File Edit ¥iew Project Source Process ‘Window Help

DPHS CRDEFFR @YALYL AR AR XBE oo MiE FlmEDO 9

Sources x

Sources for: Synthesws:’lmpler’r

- ER e k200-d144

g Sources g SnaE 4

Frocesses X Hew Source Wizard - Select Source Type

Processes:
M Add Existing Source Q IF [Coregen & Architecture Wizard)
[ Cieate New Source [] Schematic
& s. Design Utities -] Test Bench WaveFom

| =] User Document
[v] Verilog Module
(4] Verilog Test Fisture File: name:
I8 VHOL Module ‘
[T WHDL Library
[F]¥HDL Package Location
') YHOL Test Banch

‘E:\EXEPEHMIENT]\ADDIT\DN

A4dd to project

3 l <Back | [ Mest s | | Caneel
2f Processes
" -~
i il
% 3|
=

Figure-12
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File Edit ¥iew Project Source Process MWindow Help

DPES LR FZR @URAY AR AR YRE o6 hiE C=E0m @

Sources x

Sources for, | Synthesis/impler =

£ »c3s200-4t144

B Sources g Snap 4 b

Frocesses X

Processes:

New Source Wizard - Select Source Type

™ AddExisting Source
O Create New Source
= ﬁ‘ Design Utiities

q IF [Coregen & Architecture \wizard)
[2] Schematic
1] Test Berich WaveFarm
[=] User Document
ﬂ Yerlog Module
m‘. Yerlog Test Fisture
('] YHOL Modul=
WHOL Library
[F]¥HDL Package
'] WHOL Test Bench

File name:

|coda

Location

|E NEXEPERMIENTTAADDITION

Add to project

EL Processes

I ¢ Back |[ Mest > I| ~Caneel

X

Transcript

Figure-13
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File Edit Yiew Project Source Process Window Help

DPHS LD FFRD BYAAT AR AR XBERE o0 WK Flmanm ¢

Sources X

Sources for Synthesis#lmplel’:

(= ADDITION

B Souces g Snap 4 ¥

Processes x

Processes;

[ Add Existing Source
[ Create New Source
& ﬂ‘ Design Utiliies

Hew Source Wizard - Define Module

Ertity Name |c0de

Architecture Name |Eehavi0|a|

Port Name: Direction -

in

S

in

o o o

I < Back |[ Hext> I| Cancel

Transcript

Figure-14
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IMIENT1ADDITION\AD

File Edit View Project Source Process Window Help

DRAHS LR EFR SUHAAN AR &4 YRE wo MK Fl=EOoD @

Sources x
Sources for: Syntheswsf’lmpled'
~ Fapoimon

£ %c3:200- 4144

B Souices ey Snapd

Processes % Hew Source Wizard - Summary
Processes:
[ AddEsisting Source Project Mavigator will create a new skeleton source with the fallawing specifications:

[ Create New Souce
o] s‘ Design Utilites

4 »
B Processes
x ry
i A
b
E [pg FindinFiles
CAPS |
& untith. B iy, B addi =, 3 @ 11

Figure-15

5. A window shown in Figure-16 will appear. You can type your VHDL code in the right side of window
and save it by clicking on the Save button (refer Figure-17). Now in the “Processes:” window double click
Synthesize-XST as shown in Figure-18.
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\EXEPERMIENT1\ADDITION\ADDITION.1ze - [code.vhd]

Flle Edit View Project Source Process Window Help -8 X

DRPHS SR EFR BALYE AR &% YRR v pm__ [

BEDD VAL ZABBROM D2 R
i} A
Sources Iul: 2 -- Company:
@ADDIT\DN 3 -- Engineer:
o £ 53200184 o
7 s 5 -- Create Date: 23:36:36 06/28/2003
uucode-Behawulall o Tesign Wane:
7 -- Module Name: code - Behavioral
[E=——= » 8 -- Project Neme:
9 -- Target Devices:
M mSna[ i 10 -- Tool versions:
11 -- Description:
Processes: L
. 13 -- Dependencies:
[ Add Existing Source 14 -
[ Create New Souce i G
L ViewDesignSummary | 16 -- Revision 0.01 - File Creatad
& g‘ Design Utilities 17  -- Ldditional Comments:
.’:iﬁ‘ User Constraints 188 =
E ) Snthesize - <8T 13
#F3  Implement Design 20 library IEEE;
& c] Gensrate Programming 21 use IEEE.3TD LOGIC 1164.ALL;
2z use IEEE.STD_LOGIC ARITH.ALL;
23 use IEEE.STD_LOGIC UM3IGHED.ALL;
24
25  --—- Uneomwent the following library declaration if instantiating
26 --—- any Xilinx primitives in this code.
27 --library TNIZIN:
28 --use UNISIN.VComponents.all;
8
30  entity code is L
21 Demwvt | o = din ST T ACTS WERCTAD (2 dammtn N e
{ — Y 3 - 3 A i 5
E—t Processes =
code | Design Summary
—
-
Started : "Launching Design Summary".
v

LniColl |CAPS NUM | SCRL | WHDL

nero
BiseARcH

Figure-16
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\EXEPERMIENT1\ADDITION\ADDITION.ige - [co

File Edit Wiew Project Source Process Window Help -8 X
DPES LB EFE BUAATL AR 49 XBE W pa[_______ T
mE D0 QPP Z2EL ARAADE D & B

5 library IEEE: B
el 6 use IEEE.STD _LOGIC 1164.ALL:
@ADDlTlUN 7 uze IEEE.STD LOGIC ARITH.ALL:
51 €7 wo3:200-4tq144 2 use IEEE.STD LOGIC UNSIGNED.ALL;
[l code - Behaviord | 10  entity addition is
11 porti
1 e 3 1z a : in std logic_wvector {3 downto 0); --1st input value--
B Sources anaH » i) b 1 oin std_log%c_vect,arw downto 0); --2nd input value-—-
[ERASE— 14 output i out std logic wector (4 downto 0) --output result--
15 1i
P 16 end additcion;
TOCESSES: G
fel  AddEusting Source 18 architecture Behavioral of addition is
O Create New Source 19 --signal declarations—-
L Wiew Design Summary 20 signal store : std_logic_wector (4 downto O0);
EI? Dexign Utiities 21  begin
W% User Conshaints 22 4 BIT ADDITION MODULE
# 83 Synthesize-¥5T 23 process(ah)
#8)  Implement Design 2 begin,
# ) Geneale Programming 23
Z6 store <= conv_std_logic_vector((conv_integer(a) + conv_integerib)),5); -- addition --
27 output (3 downto 0) <= store(3 downto 0); -- sum --
28 output (4) <= store(d): -- Carry --
29
30
31 end process;
iz
33 end Behavioral;
34
-
 — P [ ——————— »
—E{ il code | Design Summary
—
-
Started : "Launching Design Swmmarcy”.
-
e ——————l ]

Console E Wami {36 Find in Fil
@Emos | g Wanings | [g Find in Files

Ln 28 Col45 | CAPS MUM | SCRL WHDL|

& fEsw. - @ew. - Buml .. H addt. e

Figure-17
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Xilirx - ISE - E\EXEPERMIENTTVADDITIONADDITION.ige - [code.vhd]

. [W] File Edit View Project Source Process Window Help =1 3
DR R.@ 6@ @AAAT AR &% XBE oo a&L____ T[]
" Z2ZL ARRRDE D) E

Sourc 5 library IEEE: -
suu,cesrm & use IEEE.STD_LOGIC_1164.ALL:
EapDimon 7 use IEEE.3TD LOGIC_ARITH.ALL;
= €7 #3:200-8tq1 44 § use IEEE.3TD LOGIC UNSIGNED.ALL:
"ﬂ”addmm-ﬁemwm lg entity addition is
i1 portc|
4 — » 12 a : in  std logic vector (3 downto 0); --1st input value——
Er$ Sources i Snar 4 b 13 b t in gtd logic _vector (3 downto 0): --2nd input valus-—-
[ 14 output t out std logic vector (4 downto 0) --oucput result--
15 i
Frocesses 16 end addition;
17
B AddbastingSouce 18 architecture Behavioral of addition i=
3 Create New Source 19 --signal declaratinons--
E  Wiew Design Summary 20 signal store ¢ gtd_logic_wector (4 downto 0);
.?Iﬁ‘ Design Utiities z1 begin
_i-g‘ User Constraints 22 4 BIT ADDITION MODULE
= m——-— 02 wropesaia k)
BT T
mi
w8y Ge Rerun ) .
g{ Rerun Al tore <= conv_std_logic wvector | (conv_integeria) + conv_integer(b)),5):; -- addition —-
gt i utput (3 downto 0) <= store(3 downto 0); -— sum --

utput (4) <= store(4); = BREE. =
Open Without Updating

?{: Properties...
nd process;

32
33  end Behavioral:
34
2z v,
L — e >
E'—I: Processes
A | code T Design Summary
e—
-
Started : "Launching Design Summary™.
g -
| ——— »

Consale e Ermrors _L\.Wamings [p6 Findin Files
I T
Ln28 Col45  CAPS MUM SCRLYHDL

fEaw., - @2M, - Butl. BB B adde.. &7E0

Figure-18

/&S Note: You must correct any errors found in your source files. You can check for errors in the Console
tab of the Transcript window. If you continue without valid syntax, you will not be able to simulate or
synthesize your design.

6 .Assigning Pin Location Constraints

Specify the pin locations for the ports of the design so that they are connected correctly on the Spartan-3
TYRO/PREMIER board.

To constrain the design ports to package pins, do the following before that refer the LED & SWITCH PIN
DETAILS in before pages or see board for giving the pin location.

o Verify that ADDITION is selected in the Sources window.
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o Double-click the Assign Package Pins process found in the User Constraints process group. The

Xilinx Pin out and Area Constraints Editor (PACE) opens.(refer figure 19 & 20)

Xilirx - ISE - E\EXEPERMIENT1IADDITIONVADDITION.ie - [code.vhd]

File Edit View Project Source Process ‘Window Help =& X
DPHF CEEFR SUAAN AR 4% X220 we sk [
BEMD VPP EE Z2ZL AR 0 O abzr ) [0 [#]s ~

E 3 5 library IEEE; -
SOU,CE“O,; & use IEEE.3TD_LOGIC_1164.1LL;
& anDITION 7 use IEEE.STD_LOGIC_ARITH.ALL;
5 £ ne3s200-dtq144 2 use IEEE.STD_LOGIC UNSIGMED.ALL:
g‘:};additian-Bahavior 10  entity addicion is
11 porti
4 ee————d 3 1z a i in  std logic_wvector (3 downto 0); --1st input value—-—
EEgSoulces mSna;< » 13 b : in std logic_wvector (3 downto 0); --ZInd input value--
——— 14 oUCpuL t out std logic wvector (4 downto 0] --output result--
15 i
5 16 end addition;
Processes: i
[d Acdbxsingouce 18 architecture Behawioral of addition is
2 Create New Souce 19 --zignal declarations--
L View Design Summary 20 gignal store i 8td_logic_wvector (4 downto 0);
Elﬁ‘ Design Utilities 21  begin
5% User Conshaints 22 4 BIT ADDITION MODULE

Create Timing Con 23 BEOEeSS (a,b)
Ep— 24  bhegin

Create Area Consh

i ¥y 26 store <= conv std logic vector({conv integer{a) + conv_integer(b)),5); -- addition --
£t Gandtraints Ty 27  output (3 dawnta D]_ <= sEorew downto_DJ; - sum —-
02 Synthesize - %5T 28 output(4) <= store(d): -— carry —
82  Implement Design 29

# )  Generate Programming 30
31 end process:

3z
33 end Behavioral;
34
— ac b
4 H [ e—————— b
E—t Processes %
code 3 Design Summary
-
Started : "Launching Design Surmary”.
-
—_— »

Caonzale @ Errors L ‘Wamings | [gg FindinFiles
S
Ln 28 Col 45 | CAPS | NUM SCRL | WHODL

W) untitl.. x.. B addt..

_nero
BaeARcH

FIGURE 19

o Select the Package View tab.

e In the Design Object List window, enter a pin location for each pin in the Loc column using the

seeing on board LED & SWITCHES or refer before pages in manual.
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& Xilinx PACE - E:Mifting based_dsp\7seglobject_co. ucf
File Edit Wiew IOBs Areas Tools ‘Window Help

[DEE = v u AR HD

El@@ fu] Device Architecture for xc3s200-4-tq144

[ Design Browser
3 10 Pins

& Design Object List - 0 Pins M=

[ [170 Name]1/0 Direction] Loz [Bank] 170 Std. |
[ nput I

1 | Output
| Olutput |
|_Dut|:|ut

Output

Output

Output
ot Ouput ]
4 y<5: | Output | |
| 1<E> | Olutput | I
|

| Dutput

Packae View Ji Architecture Yiew / 1 !

850

-

s

Figure 20

e Select File - Save. You are prompted to select the bus delimiter type window will open. Select

synplify VHDL/exemplar default [] and click OK.(refer FIGURE 21)
e Close PACE.

Bus Delimiter

i~ Select 10 Bus Delimiter - =|

7 HET Defaul: < >
€ WST Optional £
= Synplify Yerlog Default [ ]

7 Synplifp YHOL / Exemplar Default: [ ]

[~ Don't show this dialog again
[can be et through preferences dialog)

o]

FIGURE 21

Cancel | Help

By
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8. There are two ways of downloading the program into the target hardware, one is generating the.bit
file for downloading into the FPGA device and the other is generating the.mcs file for downloading into
the PROM device.

9. To download the program as .bit file in Boundary Scan mode, do the following steps:
i) Shunt of Jumper J2 of must be in S3 position for FPGA selection.
ii) In the Project Navigator window and click Implement design in Processes: category (refer Figure-22).

< Notice that after Implementation is complete, the Implementation processes have a green check
mark next to them indicating that they completed successfully without Errors or Warnings.

Xilinx - ISE - E\EXEPERMIENTTVADDITIONADDITION.is€ - [code.vhd]

[W] Fle Edit View Project Source Process Window Help I X

CAES LB EFRD BUAXARLT AR &0 XBRE oo pEL_ [
BEDD AL EE T2 4B B OY Db E

Source 1 -
Sources for: | Synthesisdlmpler + 2 --expl) VHDL CODE FOR 4 BIT ADDITION --
EADDITION 7
B w3 20041144 4
g ddilon - Behavi % library IEEE:
i 2CCHRID RN & use IEEE.STD LOGIC 1164.ALL
7 use IEEE.3TD LOGIC_ARITH.ALL;
] » & use IEEE.STD LOGIC_UN3IGNED.ALL:
=]
Sources Shap 4 b
L t i 10 entity addicion is
i1  port|
Fosaries iz a i in std logic vector (3 downtao 0); --1st input value--
. 13 b : in std logic veetor (3 downto 0):; —-2nd input value—-
O AddExisting Source 14 output : out std logic vector (4 downto 0) -—--output result--
[ Create New Source 15 1 - -
E  ViewDesgnSummaty | 16  end addition;
Elﬁ‘ Design Utiities alir)
_'!ig' User Conshraints 18 architecture Behavioral of addition is
& c} Sunthesize - X5 T 19 --signal declarations--
;Em——— 20__3gignal store : 3td_logic_wector (4 downto O);
i o Run egin
oty e
W e 2 BIT ADDITION HODULE
EP{ Rerun All rocess e,k
egin
,E'(t Stop =)
Open tiithout Updating Ly ore <= conv_std logic_wector {(conv_integer{a) + conv_integer(b)),5):; -- addition --
Er{ Propertiss.., utput (3 downto 0) <= store(3 downto 0); it =1 11 e
sutput (4) <= store(4); o BB
29
3o
| » ] and mrocase: b
1 ————————— )
Processes
L code
—
a
3tarted : "Launching I3SE Text Editor to edit code.wvhd".
v
_— ]
Console @) Erors | 4§\ Wamings | [ag Findin Files
(ST——
Run highlighted process Ln1Col1 | CAPS NUM SCRL|YHDL
faaw. - @om., - B, B adde. BB i e
Figure-22
- - T H -
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10. After implement design has become successful (refer Figure-23), click Generate Programming File
(refer Figure- 24). After generate programming file has been completed successfully click Manage
Configuration Project (IMPACT) (refer Figure-25).
11. Download Design to the Spartan™-3 TYRO/PRIMER Kits.
This is the last step in the design verification process.

e Connect the 9V DC power cable to the power input on the TYRO/Primer Kits. (J1).

e Connect the download cable between the PC and development board (J4).

e Check Synthesis/Implementation from the drop-down list in the Sources window ( refer figure

26).

Sources

Sources for; | Senthesizdmplementation -
RIEBD] Sonthesis/mplementation

=) 7] uc3s] Behavioral Simulation
Eu:ust-Fh:uute Simulation

BN Sources [P Snapshats |E Libraries

Figure 26

Select addition in the Sources window (refer figure 27).

Sources

Sources for; | Synthesziz/lmplementation -
ElADDITION
= £ wc3s200-dtq1 44

dition - Behavioral [code. vhidj

Er? Sources [ Snapshats |E Libraries

Figure 27

In the Processes window, click the “+” sign to expand the Generate Programming File processes.
Double-click the Configure Device (iMPACT) process (Refer FIGURE 28)
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Proceszes:

Add Existing Source

Create Mew Source

Wiew Design Summarny

Drezign Utilities

dzer Conztraints

Synthesize - =57

Implement Deszign

Generate Programming File
@ Programming File Generation Report
@ Generate PROM, ACE, or JTAG File

R

Rerun
g{' Rerun all

Er(t Skop

Open \Without Updating

 ——
%ri: Properties. ..

ﬂ:c Processes

FIGURE 28

* iMPACT - Welcome to iMPACT

Please select an action from the list below

(%) Configure devices using Boundary-Scan [JTAG)

[Automaticall}l connect to a cable and identify Boundary-Scan chain v|

() Prepare a PROM File
() Prepare a System ACE File
(") Prepare a Boundary-Scan File
B

() Configure devices

uzing Slave Serial mode

i

<Back [[ Finsh { |

Cancel ]

¢ In the Welcome dialog box, select Configure devices using Boundary-Scan (JTAG).

o Verify that Automatically connect to a cable and identify Boundary-Scan chain is selected.

e Click Finish.
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o Ifyou geta message saying that there are two devices found, click OK to continue.

o The devices connected to the JTAG chain on the board will be detected and displayed in the
iIMPACT window

o The Assign New Configuration File dialog box appears. To assign a configuration file to the

Xc3s200 device in the JTAG chain, select the addition .bit file and click Open.

R —— AE
EL Fle Edit view Operations Options Output Debug Window Help =1 =]
i EH X RBX (20 3 280 R
Floves x
ERBaundary Scan ~
BalSlaveSenal
EEISelectiAP
‘TalDesktop Configur... o T
ESystemAFE =
P xc3s200 xofl2s
MPACT Modes | el ez
IMPACT Processes x TBO

=~ Assign New Configuration File

Lok ir |5 C:/tutorial v| 4= Bt E
=l 50 wst
I _nao counter bt
[Ch_umzgs
[ isirn
IMPALCT Process Operations ||_ IC50 isimn tmp_save
A I3 templates
» PROGEESS END - En
Elap=sed time = File name: || |
_ | #4 ®®% BATCH CHMD
E File type: | All Design Files [.bit “ibt " nky " isc " bad) ]
2l
+= | Output | Eror /[ Waming =l ] ’ Bypass ]

o Ifyou geta Warning message, click OK.

e Select Bypass to skip any remaining devices.

e Right-click on the xc3s200 device image, and select Program... The Programming Properties
dialog box opens.

o Click OK to program the device.

When programming is complete, the Program Succeeded message is displayed.

Program Succeeded

e Close iMPACT without saving.

After successful configuration you can check the output on your target hardware.

115 | PANcEck soLutiony” www.pantechsolutions.net L-scheme VLS| Lab Manual

Technology Bevond the Dreams



